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14. Internet e reti locali
Sicuramente vorrete usare il vostro computer per accedere alla Rete. È con un accesso a Internet che Linux dimostra tutta
la sua potenza e flessibilità. E, non da ultimo, la sua maggiore sicurezza rispetto a Windows, a patto di configurarlo
correttamente: leggete attentamente i consigli di sicurezza di Odo.

La prima parte di questo capitolo spiega come attivare l'accesso al modem e a Internet. Dapprima presenta la
configurazione facile, che consente soltanto a root di attivare la connessione alla Rete; poi vi mostra come attivarla anche
per l'utente comune.

La seconda parte del capitolo è facoltativa e vi serve soltanto se intendete collegare il vostro computer ad altri che usano
Linux o Windows con una connessione di rete locale. Tuttavia, siccome molte delle tecniche descritte per le reti locali
valgono anche per Internet (che non è altro che una "rete locale" un tantinello più grande), vale comunque la pena di
leggere questa seconda parte anche se non usate le reti locali.

Modem e Internet

Come sempre in Linux, una buona preparazione è fondamentale. Per far funzionare il vostro modem e collegarvi a
Internet sotto Linux è indispensabile avere a portata di mano alcune informazioni.

Su quale porta seriale è collegato il modem? Se il modem è esterno, il modo più facile per scoprirlo è seguire il
cavo seriale che va dal modem al computer. Il connettore sul computer sarà probabilmente etichettato con una
sigla del tipo COM1, COM2 o simili: è questa l'informazione che vi serve.
Se il modem è interno, le cose si complicano un pochino: conviene avviare Windows e guardare nel Pannello di
Controllo, alla voce Modem, nella scheda Diagnostica. Troverete indicata la porta seriale utilizzata dal modem (sì,
lo so che può sembrare strano che un aggeggio interno usi una porta seriale, ma è così).
In un modo o nell'altro, avete scoperto a quale COM è collegato il modem. Non vi resta che tradurre il nome
Windows della porta seriale nell'equivalente Linux. Come già accennato nel Capitolo 6 (Benvenuti in un mondo
strano), COM1 equivale a /dev/ttyS0, COM2 a /dev/ttyS1, e così via. Praticamente basta sostituire COM con
/dev/ttyS e scalare di una unità il numero.

• 
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Figura 14−1. Usiamo Windows per scoprire su che porta seriale è il modem.

Si tratta di un Winmodem? Come già accennato, i Winmodem non sono utilizzabili sotto Linux. Non è facile
sapere se avete un Winmodem o no. Come regola molto generale, se avete dovuto caricare un driver apposito per
farlo funzionare sotto Windows e se il modem non funziona quando avviate il computer in modalità MS−DOS, è
probabile che sia un Winmodem. Consultate la documentazione del vostro computer e del modem. Se scoprite di
avere un Winmodem, l'unica strada è comperare un modem normale.

• 

Parametri di accesso a Internet. Qualsiasi fornitore d'accesso a Internet degno di questo nome riporta, nelle
pagine del proprio sito, le istruzioni di configurazione per accedere a Internet tramite Linux. Se così non fosse,
accedete (in Windows) alla cartella Accesso remoto e cliccate con il pulsante destro sull'icona della connessione a
Internet che usate abitualmente e volete adoperare sotto Linux.
Scegliete la voce di menu Proprietà: otterrete una serie di schede contenenti le informazioni che vi servono: il
numero di telefono è nella scheda Generale e gli altri parametri di connessione sono nella scheda Tipi di server,
dietro il pulsante Impostazioni TCP/IP.

• 

Link simbolico al modem (ovvero come faticare meno)

Una delle scoperte più interessanti che ho fatto durante la lavorazione di questo libro è che la comunità linuxiana non è
quel blocco monolitico di fondamentalisti che potrebbe sembrare a chi non ne fa parte. Verrebbe spontaneo pensare che di
fronte alla minaccia continua di essere assimilati dall'"orda barbara" degli utenti Microsoft, i linuxiani formino un fronte
compatto, senza spazio per i dissensi.

Niente affatto. Fra gli utenti Linux ci sono moderati, ortodossi, radicali e contestatori, peggio che in un partito politico (e
come i partiti politici, più è piccolo il loro peso percentuale, più sono violente le dispute interne). L'ho scoperto studiando
una cosa banale come l'impostazione del modem. Infatti la documentazione di Linux, che rappresenta il Verbo
dell'ortodossia del sistema operativo, considera riprovevole quello che sto per proporvi a proposito di modem, eppure Odo
(e con lui molti altri utenti) ha insistito perché io andassi contro il Verbo e scrivessi questa sezione.

Mah. Sinceramente non so cosa ci sia di tanto cruciale nella "configurazione del link simbolico al modem" da suscitare
aspri dibattiti e battibecchi via e−mail fra gli utenti di Linux, ma se l'umanità ha dibattuto per secoli sul numero di angeli
che possono danzare su una capocchia di spillo, forse non dovrei stupirmi.

La lezione che se ne può trarre è forse che in qualsiasi conflitto (militare, morale, razziale, religioso, politico, calcistico,
culinario) non bisogna mai considerare l'opposta fazione come una massa anonima e robotica tutta sintonizzata sullo
stesso pensiero. Anche loro hanno dubbi e dissidi individuali, proprio come noi.

Ma vengo subito al sodo. Alla fine ho accettato la tesi di Odo per due motivi fondamentali. Primo, non si contraddice mai
il proprio spirito−guida. Secondo, trovo la sua proposta molto pratica. Ve la illustro subito.

L'idea di base è che man mano che vi addentrate in Linux, il numero delle applicazioni che usano il modem tende a
crescere. Come vedremo tra poco, anche se l'applicazione è una sola, ha un file di configurazione corrispondente per
ciascun utente; in caso di modifiche al sistema occorre quindi modificare manualmente ciascuno di questi file di
configurazione.

Allo stesso tempo, è abbastanza facile che prima o poi vi capiti di cambiare il modem o di cambiarne la configurazione
(da esterno a interno, ad esempio). Questo significa che ad ogni cambiamento del modem dovrete reimpostare tutti i
programmi, uno per uno e per ciascun utente, in modo che trovino il modem sulla porta seriale giusta.

Per evitare questa scomodità, si può creare un link simbolico (descritto nel Capitolo 6, Benvenuti in un mondo strano) dal
dispositivo /dev/modem alla porta seriale dove risiede il modem. Poi si impostano i programmi, una volta per tutte, in
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modo che usino il modem che sta sulla porta seriale indicata in /dev/modem, qualunque essa sia. Così se il modem cambia
porta seriale, basta modificare il link simbolico di /dev/modem e automaticamente tutti i programmi saranno aggiornati.

Esempio pratico: avete configurato l'accesso a Internet in modo da usare il modem interno che sta sulla porta seriale
/dev/ttyS2 (la COM3 in DOS) e avete abilitato tre utenti all'uso di Internet. Immaginate di averlo fatto anche per qualche
altro programma che usa il modem: ad esempio Minicom, un programma di telecomunicazioni che trovate nel Pannello
sotto Red Hat > Internet > Minicom e che a molti ricorderà lo storico Telix disponibile in MS−DOS.

Adesso, però, volete usare un altro modem e non potete rimuovere quello interno, per cui collegate il nuovo modem a
un'altra porta seriale (diciamo COM2, cioè /dev/ttyS1). Se non usate il link simbolico, vi tocca riconfigurare manualmente,
uno per uno, ciascuno dei programmi e degli utenti che usano il modem, cambiando l'impostazione da /dev/ttyS2 a
/dev/ttyS1 in ogni file di configurazione. Poco divertente.

Con il link simbolico, invece, i programmi e gli utenti cercano il modem nel posto indicato in /dev/modem, per cui basta
modificare /dev/modem in modo che punti a /dev/ttyS1 anziché /dev/ttyS2. Ve la cavate con una sola, rapida modifica al
posto di tante modifiche quanti sono i programmi e gli utenti che usano il modem.

Convinti? Allora ecco come procedere per usare il link simbolico: c'è la maniera spiccia della riga di comando, che
consiste nell'aprire una console o una finestra di terminale, accedervi come root e digitare ln −sf /dev/ttyS1 /dev/modem.
Se però preferite l'agio dell'interfaccia grafica, procedete così:

Accedete come root e lanciate il programma control−panel.• 

Figura 14−2. La schermata iniziale di control−panel.

Cliccate sul pulsante Modem Configuration (il quinto dall'alto). Nella schermata Configure Modem, cliccate sulla
riga corrispondente alla porta seriale alla quale è collegato il modem che volete usare. Cliccate su OK e poi
chiudete control−panel. Tutto qui.

• 
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Figura 14−3. Configurare il link al modem.

D'ora in poi vi basterà impostate, una volta per tutte, i vostri programmi in modo che usino /dev/modem e non avrete più
bisogno di modificarli se cambiate modem: vi basterà rilanciare control−panel e rieseguire questa rapida modifica.

Configurare il modem sotto Linux

Avviate Linux e assicuratevi che il modem sia acceso e collegato alla linea telefonica. Fate login come root e scegliete dal
Pannello la voce Internet > kppp. Dietro questo strano nome si cela il programma di gestione dell'accesso a Internet di
Linux: in pratica è l'equivalente dell'Accesso Remoto di Windows.

Si chiama kppp non per sadismo dei programmatori, ma semplicemente perché tutte le applicazioni per l'interfaccia
grafica KDE di Linux cominciano per K e perché PPP è il nome del protocollo usato da quasi tutti i computer, compresi
quelli Windows, per accedere a Internet (PPP sta per Point−to−Point Protocol, se ci tenete a saperlo).

La prima schermata di kppp è completamente in inglese ma potete tranquillamente ignorarla: dice soltanto che potete
cliccare con il pulsante destro del mouse sui punti più importanti di qualsiasi schermata di kppp per avere aiuto (bell'aiuto:
è in inglese, purtroppo).

Cliccate sulla casella Don't show this hint again in modo da far comparire un segno di spunta: in questo modo questo
promemoria non vi scoccerà più in futuro. Poi cliccate su OK per proseguire.

Figura 14−4. La schermata iniziale di kppp.

Dato che è la prima volta che avviate il programma, non ci sono connessioni predefinite da scegliere: dovete impostarle.
Cliccate sul pulsante Configurazione e scegliete la scheda Dispositivo.
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Figura 14−5. La scelta del dispositivo in kppp.

Nella casella Modem dovete scegliere il nome Linux della porta seriale alla quale è collegato il modem oppure, se avete
impostato il link simbolico, lasciare /dev/modem. Se volete verificare la correttezza della vostra scelta, selezionate la
scheda Modem e cliccate sul pulsante Interroga modem:

Se ottenete il messaggio Modem pronto, seguito da una finestra intitolata Responso interrogazione modem, siete a
posto: avete indicato correttamente il modem a Linux.

• 

Se avete sbagliato, Linux vi dice Spiacente, impossibile accedere al modem e vi tocca provare con un altro valore
della casella Modem. Assicuratevi che il modem sia acceso!

• 

Un'altra cosa che vi conviene impostare nella scheda Modem è il volume dell'altoparlante del modem. Almeno per i primi
collegamenti, è meglio tenerlo alzato (non a zero, insomma), in modo da poter ascoltare quello che succede lungo la linea.
È un metodo molto semplice per diagnosticare eventuali problemi.

Nella scheda PPP, invece, attivate la casella Aggiungi al Pannello appena connesso. In questo modo, non appena la
connessione viene attivata, nel Pannello compare un'icona che rappresenta il modem e sulla quale potete cliccare per
chiudere la connessione a Internet, in modo molto simile a Windows.

Configurare l'accesso a Internet

Risolta la configurazione del modem, è ora il turno di quella dell'accesso a Internet. Cliccate sulla scheda Accounts e poi
sul pulsante Nuovo.

Nella scheda Chiama, le caselle vanno compilate immettendo un nome a piacere nella casella Nome connessione e
il numero di telefono del fornitore d'accesso nella casella Numero telefonico. Il tipo di autenticazione giusto,
invece, dovrebbe essere indicato nei dati forniti dal vostro fornitore d'accesso (mal che vada, potete provarli tutti e
vedere quale funziona).

• 
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Figura 14−6. La scheda Chiama nella configurazione di un account Internet.

Nella scheda IP non c'è nulla da modificare, dato che praticamente tutti i fornitori d'accesso a Internet assegnano
un indirizzo IP dinamico agli utenti connessi via modem.

• 

Nella scheda DNS va indicato il nome di dominio (ad esempio tin.it per Tin.it, libero.it per Libero, eccetera) e
l'indirizzo IP del DNS (domain name server) del vostro fornitore d'accesso. Anche questi sono dati che vi deve
dare il fornitore. Nel caso peggiore, potete utilizzare l'indirizzo IP di qualsiasi domain name server di Internet,
anche se non è quello del vostro fornitore; sarà un po' più lento, ma sempre meglio di niente.
Cliccate sul pulsante Aggiungi: l'indirizzo IP che avete immesso nella casella Indirizzo IP del DNS viene riportato
nella casella Lista indirizzi DNS e potete specificare altri indirizzi IP di domain name server da usare se quello
precedente non funziona o è troppo intasato.

• 

Le altre schede della finestra sono dedicate a raffinatezze che non è il caso di introdurre adesso. Non lasciatevi tentare
dalla scheda Costi telefonici: a causa del continuo rincorrersi delle offerte dei vari operatori telefonici, i valori per l'Italia
sono perennemente obsoleti. Va detto che le versioni aggiornate di questi valori sono prelevabili da Internet, ma per il
momento non conviene complicarsi la vita.

Cliccate su OK per chiudere la schermata Nuovo account e poi di nuovo su OK per tornare alla schermata di kppp, il cui
menu a discesa ora contiene il nome dell'account che avete appena creato. Immettete il vostro userid o identificativo di
accesso (quello indicato in Nome utente nell'Accesso Remoto di Windows) nella casella Nome utente per l'accesso e la
vostra password nella casella omonima.

Pronti per il grande salto? Allora cliccate su Connetti. Se tutto va bene, compare il messaggio Chiamata in corso seguito
dal numero di telefono del fornitore d'accesso che Linux sta chiamando. A questo fa seguito Sto accedendo alla rete... e
poi la schermata di kpp scompare, trasformandosi in un'icona nel Pannello.

Se volete verificare che davvero avete accesso a Internet, usate kfm, che è a tutti gli effetti un piccolo browser: basta
digitare l'indirizzo di un sito che volete visitare. Se il sito compare in kfm, vuol dire che siete in Internet con Linux.
Complimenti.
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Figura 14−7. Primo collegamento a Internet con Linux e kfm.

Per terminare la connessione, cliccate con il pulsante destro sull'icona e scegliete Disconnetti.

Mi raccomando, non usate subito Linux per collegarvi assiduamente a Internet. Nel suo stato naturale, Linux è più aperto
di Windows verso eventuali intrusioni da Internet. Una volta modificato, è molto più sicuro di Windows, ma siccome per
ora non avete ancora apportato queste modifiche, descritte nel Capitolo 18 (Sicurezza), usate Linux per Internet il meno
possibile. Se lo fate, non collegatevi con l'utente root, come descritto tra poco.

Dettagli importanti

Cliccando con il pulsante destro sull'icona del modem nel Pannello avrete notato una voce di menu chiamata Dettagli. Se
cliccate su questa voce mentre è attiva la connessione a Internet, ottenete una schermata ricca di informazioni sul
funzionamento della connessione: byte trasmessi, byte ricevuti, indirizzi IP della connessione, un grafico dell'efficienza
di trasferimento dati, e altro ancora.
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Figura 14−8. Dettagli sulla connessione a Internet in kppp.

Internet (non) per tutti

Nell'installazione standard di Red Hat Linux, il programma kppp, che è l'equivalente Linux dell'Accesso remoto di
Windows, è accessibile soltanto all'utente root; gli utenti comuni possono usarlo soltanto se conoscono la password di
root. Per consentire anche agli utenti comuni di utilizzare kppp e quindi collegarsi a Internet senza dover rivelare loro la
password di root, procedete come segue:

Accedete a Linux come root.• 
Cancellate o rinominate il file /usr/bin/kppp.• 
Digitate il comando chmod u+s /usr/sbin/kppp in una console o in una finestra di terminale. Fate attenzione alla
differenza fra bin e sbin. Questo serve a consentire agli utenti di lanciare kppp assegnandogli automaticamente i
privilegi di root che gli servono per accedere al modem.

• 

Nel Pannello, scegliete Pannello e poi Modifica menu. Compare kmenuedit, noto anche come l'Editor menu di
Linux, ossia l'applicazione che consente di personalizzare i menu del Pannello, già vista nel Capitolo 13.

• 

Figura 14−9. Modificare i menu con kmenuedit.

Nella finestra di kmenuedit, cliccate sulla voce Internet; nel sottomenu che compare, cliccate con il pulsante
destro su kppp. Questo fa comparire un menu, dal quale scegliete Cambia.

• 
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Figura 14−10. Cambiare la voce di menu per kppp.

Ottenete sullo schermo una finestra contenente tutti i parametri della voce di menu kppp. Tanto per cominciare,
nella casella Nome potete cambiare il nome di questa voce di menu da un ben poco intuitivo kppp a un più chiaro
Accesso a Internet (o altra descrizione a vostro piacimento). Nella casella Execute, invece, dovete specificare
/usr/sbin/kppp. Salvate le modifiche e chiudete kmenuedit. Queste modifiche si applicano a tutti gli utenti.

• 

Una volta fatte queste modifiche, ciascun utente ha accesso a kppp tramite il Pannello, alla voce Internet > Accesso a
Internet (al posto di Accesso a Internet ci sarà eventualmente la descrizione a vostro piacimento che avete immesso prima)
e può configurarsi la propria connessione come descritto sopra. I parametri di connessione di ciascun utente sono
memorizzati principalmente nella home directory dell'utente, all'interno della sottocartella /.kde/share/config/, nel file
kpprc.

Duplicare una connessione

Se tutti gli utenti utilizzeranno la stessa connessione a Internet, non è necessario ripetere per ciascun utente la trafila di
immettere tutti i parametri di connessione: basta ricopiare un file. Se avete definito l'accesso a Internet come root, il file
contenente i parametri di connessione è /root/.kde/share/config/kpprc. Copiatelo alla directory corrispondente di ciascun
utente (ad esempio, per l'utente cesira il file va ricopiato in /home/cesira/.kde/share/config/kpprc), assegnate la proprietà
del file all'utente e il gioco è fatto.

A proposito di sicurezza: il file kpprc contiene (in chiaro) la password della connessione a Internet, ma gli utenti normali
non possono aprire i file kpprc degli altri utenti; solo root può farlo. Provare per credere. Questo impedisce agli utenti
dispettosi di rubarsi le password a vicenda e connettersi a Internet spacciandosi per un altro utente.

Grazie a queste modifiche, tutti gli utenti comuni hanno accesso a kppp e quindi a Internet. Ma supponiamo che sia
necessario porre delle restrizioni ad alcuni utenti, ad esempio perché il computer di casa è condiviso da più persone e
volete impedire che qualcuno si attacchi a Internet e si metta a chattare come un ossesso, regalandovi una bolletta
telefonica dolorosissima e occupandovi la linea per ore e ore. Di certi genitori proprio non ci si può fidare.

Ci sono vari modi per assegnare agli utenti comuni il diritto di usare kppp. Quello che vi presento qui è, a mio avviso, il
metodo più semplice: l'utente root crea un file, /etc/kppp.allow, che contiene la lista degli utenti autorizzati a usare kppp, e
rende questo file leggibile a tutti (ma non modificabile, per ovvi motivi). Solo gli utenti indicati in questo file potranno
accedere a Internet.
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In dettaglio, si procede così:

Accedete al sistema come root.• 
Avviate l'editor di testi dal Pannello (è sotto Applicazioni) e digitate, uno per riga, i nomi degli utenti da
autorizzare all'uso di kppp. Se volete immettere dei commenti nel file, iniziate la riga con il simbolo #.
Nell'esempio mostrato qui sotto, soltanto gli utenti normale e cesira possono usare kppp; cavia e bimbogigi sono
elencati nel file, ma vengono ignorati (e quindi non abilitati all'uso di kppp) perché prefissati dal simbolo #.

• 

Figura 14−11. Definire gli utenti autorizzati a Internet.

Salvate il file con il percorso e il nome /etc/kppp.allow.• 

Soltanto root ha il potere di modificare questo file e quindi cambiare le autorizzazioni all'uso di Internet. Chi non è
autorizzato riceve il messaggio Non avete i permessi per usare kppp − Contattate l'amministratore di sistema. Gli utenti
comuni possono comunque leggere il file e rodersi il fegato vedendo chi ha accesso alla Rete e chi no (e magari perché, se
root ha messo qualche commento).

Configurare il browser: Netscape Navigator

Come avete visto nelle pagine precedenti, kfm può essere usato tranquillamente come browser. Tuttavia non è l'unico
browser a vostra disposizione in Linux. La vostra installazione, infatti contiene anche i due opposti estremi dei browser:
lynx, che è un browser di puro testo, velocissimo e microscopico (un megabyte tutto compreso), che gira in una finestra di
terminale, e il superaccessoriato Netscape.

In più, se avete installato StarOffice, potete anche provare il browser incluso in quest'applicazione. Se invece cercate una
via di mezzo fra il gigantismo di Netscape e StarOffice e il minimalismo di lynx, potete provare Opera
(http://www.operasoftware.com), un browser a pagamento rinomato per la sua velocità e per le sue dimensioni ed
occupazioni di memoria estremamente contenute.

Qui vi descrivo soltanto Netscape perché ha un vantaggio fondamentale: è disponibile anche sotto Windows, come
probabilmente già sapete (lo è anche Opera). In questo modo avrete lo stesso modo di funzionare del browser sia sotto
Windows, sia sotto Linux, e questo renderà meno difficile imparare l'uso di Linux per Internet.

Per lanciare Netscape per la prima volta e configurarlo, cliccate sull'icona che rappresenta la ruota del timone nel
Pannello, oppure scegliete dal menu la voce Internet > Netscape.

Al suo primo avvio, Netscape vi chiede di accettare la licenza (cliccando su Accept) e vi avvisa che è stata creata una
sottodirectory della vostra home directory in cui verranno tenuti i suoi file temporanei (tecnicamente, la sua cache).
Questa procedura verrà rieseguita per ciascun utente che lancia Netscape. Cliccate prima sul pulsante Accept e poi sui
pulsanti OK per accettare la creazione delle directory.
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Prima di proseguire, mi fermo per una precisazione. Tutti lo chiamano semplicemente Netscape, ma in realtà il
programma si chiama Netscape Communicator; Netscape è semplicemente il nome della società che produce il
programma (un po' come avere una Punto e chiamarla semplicemente Fiat). Netscape Communicator contiene il browser
Navigator, il programma per e−mail e newsgroup Messenger, e l'editor di pagine Web Composer. Volendo essere pignoli,
dovrei quindi chiamarlo Communicator, ma mi adeguerò all'uso comune parlando semplicemente di Netscape sempre e
comunque.

Già a questo punto, se vi collegate a Internet siete in grado di usare Netscape per navigare nel Web, ma come dicevo
potete usarlo anche per gestire e−mail e newsgroup, se gli immettete i parametri corrispondenti. Se usate Netscape in
Windows, sapete già dove mettere le mani per immettere i vostri parametri. Se siete digiuni di Netscape, andate in Edit >
Preferences e scegliete Mail & Newsgroups.

Lo so che è brutto autocitarsi, ma i dettagli della configurazione di browser e programmi per e−mail e newsgroup sono
descritti estesamente in un altro mio libro, Internet per tutti; siccome il suo testo è disponibile integralmente e
gratuitamente su Internet presso http://www.attivissimo.net, eviterò di ripetere qui tutta la tiritera.

Figura 14−12. Netscape sotto Linux.

E−mail

Netscape è in grado di gestire l'e−mail, ma se preferite usare un'applicazione separata e più piccola per gestire la vostra
posta Internet, Linux mette a disposizione kmail, che trovate nel Pannello (l'icona con la busta e la E arancione) e nel
menu sotto Internet > Client Posta.

Al primo avvio, kmail si ferma e chiede di creare, al di sotto della home directory dell'utente, una directory in cui
conservare i messaggi spediti e ricevuti: cliccate su OK per accettare. Fatto questo, immettete i vostri dati nelle schede del
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programma, ricavandoli dal vostro programma di e−mail per Windows. In particolare, fate attenzione ad alcuni punti
critici:

Nella scheda Identità, correggete il valore predefinito per il vostro indirizzo di e−mail e metteteci quello vero.• 
Nella scheda Rete, scegliete SMTP anziché sendmail e correggete il nome del server, immettendo quello del
server di posta del vostro fornitore d'accesso.

• 

Sempre nella scheda Rete, cliccate su Aggiungi per aggiungere almeno un account del quale volete leggere i
messaggi. Alla richiesta Scelta account, selezionate POP3 e cliccate su OK. Nella finestra Configure account che
compare, immettete i dati della vostra casella di posta e disattivate la casella Elimina la posta dal server.

• 

Figura 14−13. Configurare i parametri per l'e−mail in kmail.

Nella scheda Compositore messaggi, attivare l'opzione In seguito in modo che la posta che scrivete non venga
spedita immediatamente e quindi possiate preparare i vari messaggi prima di collegarvi.

• 

Terminata l'impostazione del programma, collegatevi a Internet e poi scegliete in kmail la voce File > Controlla posta.
Attendete qualche minuto: se tutto funziona, dovreste ricevere da Internet una copia dei messaggi presenti nella vostra
casella di e−mail. Il primo collegamento sarà probabilmente più lungo della norma; i successivi saranno di durata
normale.
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Figura 14−14. Riceviamo la posta con kmail.

Ho detto che ricevete una "copia" della vostra posta perché per sicurezza, visto che state facendo delle prove, vi ho
consigliato di non eliminare la posta dal server del vostro fornitore. Di conseguenza i messaggi vengono scaricati sulla
vostra macchina ma restano disponibili sul server di posta del vostro fornitore per essere prelevati in seguito dal vostro
abituale programma di posta per Windows. In questo modo non vi troverete con un po' di messaggi da leggere con kmail e
il resto da leggere con il vostro programma per Windows.

Fate qualche prova di funzionamento: il metodo di collaudo più tipico è mandare un messaggio a se stessi, ma potete
anche provare a spedirne qualcuno ad amici e colleghi chiedendo loro di confermarvi la ricezione del messaggio sia via
e−mail, sia a voce o per telefono. In questo modo provate a vedere se funzionano la ricezione dei messaggi e le
impostazioni del campo Risposte all'indirizzo (noto anche come reply−to), che sono indispensabili se volete che la gente
risponda ai vostri e−mail.

Per spedire un messaggio: File > Nuovo compositore messaggi. Al termine cliccate sulla bustina per spedire subito o
scegliete File > Spedisci per mettere il messaggio in coda di uscita e spedirlo successivamente.

Figura 14−15. Spedire un e−mail da Linux con kmail.
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Newsgroup

Ci sono molti newsreader (programmi per gestire i newsgroup) per Linux, e il vostro computer ne ha già uno preinstallato
di nome KRN, disponibile nel Pannello sotto Internet > Client News, ma se volete usare Netscape perché avete
dimestichezza con questo programma sotto Windows, fate pure. Anche qui la procedura è molto simile a quella della
versione Windows del programma, per cui se siete già pratici potete saltare queste brevi istruzioni di configurazione.

Collegatevi a Internet.• 
Avviate Netscape e scegliete Edit > Preferences. Nella sezione Mail & Newsgroups, selezionate la voce
Newsgroup servers, e cliccate su Add. Immettete il nome del news server, come indicato dal vostro fornitore
d'accesso, e cliccate su OK. Poi cliccate su Set as Default per usare quel news server come server predefinito.

• 

Figura 14−16. Impostare il news server in Netscape per Linux.

Nella finestra principale di Netscape Navigator, cliccate sul menu Communicator e poi scegliete la voce
Messenger. Compare la finestra di gestione di e−mail e newsgroup, nella quale trovate sulla sinistra il nome del
news server. Cliccate sopra questo nome con il pulsante destro del mouse per far comparire un menu, dal quale
scegliete Subscribe to newsgroups.

• 

Il programma si collega al news server e inizia a prelevare l'indice dei newsgroup. Siccome è in genere un indice
piuttosto lungo, è normale che ci metta diversi minuti. Quando compare l'indice che elenca i newsgroup
disponibili, cliccate su quelli che vi interessano e poi cliccate sul pulsante Subscribe. Infine cliccate su OK per
tornare alla schermata principale.

• 
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Figura 14−17. Prelevare la lista dei newsgroup e scegliere i newsgroup che ci interessano.

Se cliccate sul nome di un newsgroup, nella zona di destra della schermata principale compaiono i titoli dei
messaggi. Il problema è che spesso la finestra del programma è un po' sbilanciata e bisogna regolare le dimensioni
delle sue sezioni per rendere visibile la sezione contenente l'elenco dei titoli e il testo del messaggio.
Il trucco sta nel cliccare sul quadratino che trovate in basso nella riga che separa la porzione di sinistra della
schermata da quella di destra: fatto questo, potete trascinare e ridimensionare le porzioni della schermata a vostro
piacimento.

• 

Figura 14−18. Il pulsantino che consente di ridimensionare le parti della schermata.

Cliccando sul titolo di un messaggio, il programma preleva da Internet il testo corrispondente. Il resto dell'uso del
programma è del tutto standard e credo non farete fatica a orientarvi, soprattutto se avete dimestichezza con i newsgroup e
conoscete già Netscape per Windows.
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Altre applicazioni per Internet

Internet non è soltanto e−mail, Web e newsgroup, per cui Linux offre molti programmi per altre funzioni utili o
ricreative della Rete, come ICQ e il chat di IRC. Ecco un elenco parziale dei programmi per Internet già preinstallati da
Red Hat Linux:

kSirc, un programma per IRC;• 
karchie, per la ricerca di file negli archivi "vecchio stile" della Rete;• 
ftp, sia come comando nelle finestre di terminale e nelle console, sia come programma client, di nome NcFTP;• 
un'infinità di comandi per Internet da digitare in una finestra di terminale o console, fra cui traceroute, ping e
telnet.

• 

Se cercate un programma per ICQ sotto Linux, probabilmente non lo troverete preinstallato, ma dovrete prelevarlo da
Internet: provate Licq. Su Internet, ovviamente, troverete intere biblioteche di programmi Linux per le più svariate
applicazioni connesse a Internet: c'è soltanto l'imbarazzo della scelta. Nel Capitolo 22 (Risorse) trovate gli indirizzi delle
principali biblioteche Linux.

A proposito di telnet: Odo mi scongiura di raccomandarvi di non usare mai questo programma su Internet. Telnet è uno
strumento molto potente, tanto che vi consente di comandare a distanza un computer esattamente come vi se foste seduti
davanti.

Purtroppo questo suo potere lo rende un bersaglio altamente desiderabile per gli intrusi, anche perché la trasmissione dei
dati fra i due computer connessi da telnet non è cifrata o protetta in alcun modo e quindi è facilmente intercettabile; una
volta intercettata, prendere il controllo dei computer interessati e carpirne i dati è una passeggiata.

Probabilmente non vi capiterà mai di usare telnet, ma se si dovesse presentare una situazione che ne richiede l'uso su
Internet o su reti locali insicure, leggete il Capitolo 19 (Manutenzione di base) per scoprire come creare una connessione
di tipo telnet un po' meno colabrodo.

Mettere in rete Linux

Come dicevo, questa sezione del capitolo è del tutto facoltativa, e vi serve soltanto se disponete di due o più computer e li
volete collegare in rete locale (ad esempio un portatile e un PC fisso), o se volete installare Linux su un computer che fa
parte di una rete locale; diversamente potete anche saltarla.

Collegare i computer in rete tramite schede Ethernet, anche in casa, sta diventando un'abitudine sempre più diffusa, anche
grazie ai costi ridicolmente bassi di queste schede. Inoltre installare Linux sui vecchi computer è un ottimo sistema per
dare loro nuova vita a costo zero.

Grazie alle caratteristiche di Linux, inoltre, anche computer di prestazioni modeste tornano utili, perché è abbastanza
facile trasformarli in "terminali" grafici che sfruttano la maggior potenza di calcolo degli altri computer presenti nella rete
locale.

Inoltre, visti i tempi che corrono, è consigliabilissimo riesumare un vecchio PC (va bene anche un umilissimo 486) e
installargli Linux, usandolo come firewall gratuito per tenere fuori gli intrusi quando vi collegate a Internet. Collegando
questo PC a Internet (con ADSL, ISDN o anche via modem) e collegando gli altri computer della rete locale al PC Linux,
tutti i computer saranno in grado di condividere la connessione a Internet e godranno di un ragionevole livello di
protezione. Senza spendere una lira.

Da Windows a Linux 07/09/03 10:04:00

16/22



Non che queste cose non si possano fare anche con Windows, per carità; solo che dovreste comperare una licenza di
Windows per ogni computer che riesumate, e in più dovreste procurarvi il software per firewall sotto Windows. Alla fine,
la spesa per il sistema operativo supererebbe il valore dei computer.

Siccome siete ancora alle prime armi con Linux, gli obiettivi di questa sezione sono abbastanza modesti: si tratta
semplicemente di riuscire a stabilire uno straccio di connessione fra due macchine collegate da un cavo Ethernet, tanto per
essere certi che tutto è impostato correttamente. Gli affinamenti, come al solito, verranno in seguito.

Tralascio la parte hardware del cablaggio perché è al di fuori della portata di questo libro, ma trovate fior di descrizioni
nella documentazione online di Linux. Inoltre presumo che abbiate già un minimo di dimestichezza con il collegamento in
rete Ethernet di due o più PC Windows tramite il protocollo TCP/IP.

Per i solutori più che abili

La configurazione della scheda di rete è una delle parti più sofferte della messa a punto di Linux. Se non siete
particolarmente fortunati, vi troverete in serie difficoltà. Vi consiglio di tenere a portata di mano il numero di telefono di
un linuxiano esperto e di prepararvi a lunghe ricerche in Internet per sapere come gli altri utenti hanno risolto la
configurazione del vostro modello di scheda di rete.

Raccogliere informazioni

Prima di iniziare la configurazione della rete locale in Linux occorre estrarre da Windows un po' di informazioni
sull'argomento. Lanciate quindi Windows e procedete come segue:

Lanciate il programma winipcfg per scoprire il tipo di scheda di rete, il suo indirizzo, l'indirizzo IP e la maschera
di sottorete (Subnet mask).

• 

Figura 14−19. Windows rivela un po' di informazioni utili.

Andate nel Pannello di Controllo e attivate la sezione Sistema. Nella scheda Gestione periferiche trovate elencata
la scheda di rete con il suo nome completo (nel mio caso, ad esempio, si tratta di una Realtek RTL8019 PnP,
anche se winipcfg la considera una Novell 2000 perché la scheda, come tante altre, emula la Novell 2000).
Cliccando su Proprietà scoprite anche l'intervallo di input/output e il livello di interrupt (noto anche come IRQ).

• 
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Figura 14−20. Altri dettagli sulla scheda di rete rivelati da Windows.

Un'altra cosa da fare prima di cominciare è collegarsi a Internet e usare un motore di ricerca per trovare informazioni sulla
vostra specifica scheda di rete in abbinamento a Linux. In genere è sufficiente digitare il nome della scheda seguito da
linux per trovare le informazioni che vi servono. In genere, purtroppo, saranno in inglese, ma non si può certo avere tutto.

Armati di queste informazioni, dovreste poter configurare Linux per la connessione in rete locale.

Cambiare il nome del computer

Ci sono due ottime ragioni per cambiare il nome del proprio computer (più propriamente si tratta di cambiare il proprio
nome di host o hostname). La prima, e la più importante per un linuxiano, è eliminare quel banale localhost che imbratta
tutti i prompt delle console e sostituirla con qualcosa di più personale, tipicamente un nome di un personaggio dei fumetti
giapponesi. La seconda è dare un nome che renderà univocamente identificabile il computer quando lo collegherete in rete
(locale o Internet).

Accedete come root, aprite una finestra di terminale e digitate linuxconf. Se non ottenete alcuna reazione, provate a
specificare il percorso, digitando /sbin/linuxconf se neppure questo funziona, linuxconf non è stato installato e vi tocca
provvedere all'installazione, come accennato nel Capitolo 13. Nella distribuzione Red Hat 7.0, il pacchetto di linuxconf è
sul primo CD−ROM e si chiama linuxconf−1.19r2−4.i386.rpm.

Nella sezione Rete, sottosezione Client tasks, trovate una riga etichettata basic host information. Cliccatevi sopra per
ottenere la schermata mostrata qui sotto.
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Figura 14−21. Usare linuxconf per cambiare il nome del computer.

Nella casella host name or IP number, immettete il nome che avete scelto per il vostro computer. Ci sono delle regole
piuttosto complesse per l'assegnazione del nome, descritte in modo molto umoristico in inglese in un documento chiamato
RFC1178 disponibile su Internet; non sono vincolanti, ma rispettarle è altamente consigliabile per la vostra stessa
convenienza. Per il momento, scegliete un nome qualsiasi, tutto in minuscolo e senza spazi. Nel mio caso ho scelto
deepspace9, in omaggio alla serie di Star Trek (è la stazione spaziale dove lavora Odo. Il loro Odo, ovviamente).

Cliccate su Accetta e poi su Act/Changes. A seconda della versione di Red Hat Linux e di linuxconf che usate, ottenete
uno dei due risultati descritti qui sotto.

In Red Hat Linux 6.2, arrivate a una scheda chiamata Status of the system, nella quale cliccate su Activate (i più
prudenti possono cliccare prima su Preview per avere un'anteprima delle modifiche che eseguirà tra poco
linuxconf) e attendete qualche secondo finché si vuota la finestra. Poi cliccate su Quit: ottenete la richiesta di
scegliere fra Activate, Preview e Don't quit: scegliete la prima opzione per chiudere linuxconf e rendere effettive
le modifiche.

• 

In Red Hat Linux 7.0, invece, può succedere quello che ho descritto per la versione 6.2, ma soprattutto le prime
volte può comparire un messaggio Nothing to do e poi linuxconf termina. Va bene lo stesso, le modifiche
vengono applicate comunque.

• 

Ricordatevi queste sequenze, le incontreremo di nuovo molte volte.

Non aspettatevi di poter aprire una finestra di terminale o una console e di vedere subito il frutto dei vostri sforzi nel
prompt. Dovete proprio riavviare Linux: è una delle poche modifiche per le quali devo consigliarvi il riavvio.

Odo, che aborrisce l'idea di dover riavviare un sistema operativo per un cambio di configurazione, mi ha spiegato che in
effetti esiste un modo per evitare il riavvio (con il comando hostname). Tuttavia in questo caso le applicazioni aperte
potrebbero non accorgersi subito del cambio di nome, e in più ci sono altri problemi che non sto a raccontarvi, per cui vi
conviene riavviare e basta. Fatelo prima di proseguire questo capitolo.
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Configurare la scheda di rete Ethernet

Il passo successivo, ora che avete battezzato il computer, è dargli un identificativo Ethernet e far riconoscere a Linux la
scheda di rete installata nel computer. Per quest'operazione potete ricorrere di nuovo al programma linuxconf.

Accedete come root.• 
Lanciate linuxconf e scegliete Rete > Client tasks > basic host information, come avete fatto prima per definire il
nome del computer.

• 

Scegliete la scheda Adaptor 1 (c'è più di una scheda Adaptor, cioè "adattatore [di rete]", perché Linux può gestire
più di una scheda di rete).

• 

Assicuratevi che siano attivati i pulsanti Enabled e Manual.• 
In Primary name + domain specificate un nome a vostro piacimento; conviene usare ancora quello che avete
assegnato prima al computer. Questo sarà il nome con il quale verrà identificato il computer quando vi accedete
tramite la scheda di rete (ad esempio da un altro computer).

• 

Nella casella IP address, immettete l'indirizzo IP che desiderate assegnare al computer. Per convenzione e per
evitare conflitti se vi collegate a Internet, si deve dare un indirizzo del tipo 192.168.x.y, dove x è un numero a
piacere fra 0 e 254 e y è ancora un numero a piacere, ma stavolta tra 1 e 255. Odo raccomanda, per buona creanza,
di evitare 192.168.0.1 e 192.168.0.255 perché solitamente questi indirizzi vengono usati per funzioni speciali.
È importantissimo che non ci siano due computer con il medesimo indirizzo IP nella stessa rete (la stessa regola
vale anche per Internet). Se avete già collegato via Ethernet questo computer in Windows, potete riutilizzare lo
stesso indirizzo IP che gli avete dato in Windows.

• 

Nella casella Netmask specificate la sottorete di cui farà parte il computer. Solitamente, per le reti locali numerate
192.168.x.x si imposta 255.255.255.0, che potete anche scegliere dal menu a discesa.

• 

Nella casella Net device, scegliete dal menu a discesa la voce eth0. Questo è il nome Linux della prima scheda di
rete (nel nostro caso, è anche l'unica).

• 

La scelta per la casella Kernel module dipende dal modello di scheda di rete che avete. In genere quasi tutte
emulano la NE2000, per cui potete provare a scegliere la voce ne o ne2k−pci del menu a discesa, ma nel dubbio
consultate la documentazione online di Linux e della vostra scheda (per esempio, le voci di menu che iniziano con
3c riguardano schede della 3Com).

• 

Le caselle I/O port e IRQ sono etichettate come facoltative, ma in realtà con molte schede di rete sono caselle
obbligatorie. Specificate qui l'intervallo di input/output e l'interrupt che avete ricavato dall'analisi con Windows.
L'intervallo di input/output va specificato nel formato 0xNNN, dove NNN è la prima parte del valore indicato da
Windows, senza lo zero iniziale. Ad esempio, se Windows indica 0280−029F, dovete immettere 0x280.

• 

Cliccate su Accetta e poi su Act/Changes. Poi cliccate su Activate e aspettate che si vuoti la schermata.• 
Sempre in linuxconf, scegliete Rete > Client tasks > Name server specification (DNS). Disattivate il pulsante DNS
is required for normal operation. Fate molta attenzione a non dimenticare o sbagliare questo parametro, altrimenti
il riavvio di Linux potrebbe essere incredibilmente lento e anzi sembrerà essersi bloccato. In tal caso, pazientate:
alla fine Linux riuscirà a partire e potrete correggere l'errore.

• 

Scegliete la sezione o scheda Controllo e la voce Verifica lo stato dei servizi. Cercate nell'elenco di destra il nome
Sendmail e cliccatevi sopra. Nella schermata che compare, cliccate su Stop e disattivate il pulsante Automatic.
Sendmail è un programma di gestione avanzata della posta, che trasforma il vostro computer in una centrale di
smistamento per la posta di più utenti. Non è necessario per l'uso normale di Linux su un personal computer di
casa o d'ufficio, ma il programma di installazione lo installa e lo attiva lo stesso. Il suo problema è che se non lo
disattivate, rende lentissimo il riavvio del computer una volta che avete configurato i servizi di rete.

• 

Cliccate su Accetta e poi su Quit per terminare linuxconf. Vi viene chiesto di confermare le modifiche cliccando
su Activate, poi linuxconf termina.

• 

Riavviate il computer: durante il riavvio dovreste vedere un messaggio che parla di attivazione di eth0:
specificamente, dovreste vedere la dicitura Bringing up interface eth0 [OK]. Se la vedete e Linux si avvia
regolarmente, la configurazione di rete è davvero a posto. In caso contrario, e se l'avvio si blocca, non spegnete
subito il computer: lasciatelo tranquillo, anche per diversi minuti se necessario. Alla fine riuscirà probabilmente a

• 
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partire e potrete intervenire sulla configurazione della rete usando linuxconf.
Aprite una finestra di terminale e digitate ifconfig. Se non ottenete risposta, provate a digitare /sbin/ifconfig. Se
tutto funziona, ottenete una schermata che elenca due dispositivi, eth0 e lo. Quest'ultimo è il cosiddetto loopback,
una connessione di rete virtuale sempre attiva in Linux per consentire varie prove tecniche della rete. Se vedete i
dettagli di eth0 mostrati in Figura 14.22, siete a posto. Se c'è elencato soltanto lo, siete nei guai. Chiamate un
linuxiano e siate molto gentili: la configurazione delle schede di rete è una brutta gatta da pelare.

• 

Figura 14−22. Il comando ifconfig conferma l'attivazione della scheda di rete.

Primi passi nella rete

Il primo controllo da effettuare per vedere se la rete locale funziona consiste nell'usare il comando ping. Questo comando
si limita a mandare un pacchetto di byte verso l'indirizzo IP specificato e aspetta che tornino indietro, misurando il tempo
intercorso. Ping è una delle forme più elementari di comunicazione in rete: se non funziona questo, non può funzionare
nient'altro.

Uno dei motivi per cui ping potrebbe non funzionare anche se la rete è fisicamente a posto è la presenza di un firewall che
blocca anche i ping per motivi di sicurezza. Prima di provare ping, assicuratevi che non sia attivo un firewall di qualsiasi
genere.

Il primo ping da fare è verso noi stessi: aprite una finestra di terminale e digitate ping 127.0.0.1 per vedere se funziona
correttamente il comando. Se ottenete una schermata come quella mostrata qui, siete a cavallo. Ricordatevi di
interrompere ping digitando Ctrl−C.

Figura 14−23. Il primo ping di Linux.
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Se questo primo ping ha funzionato, potete provare un ping verso l'indirizzo IP di un altro computer al quale siete
collegati. Una risposta positiva a questo ping significa che il livello fisico della connessione, cioè schede e cavi di rete,
funzionano correttamente e vengono riconosciuti bene da Linux. Questa è una verifica basilare e indispensabile prima di
provare a usare servizi di rete più complessi.

Fra l'altro, potete usare ping anche da Windows: aprite una finestra DOS e digitate ping seguito dall'indirizzo IP del
computer sul quale sta girando Linux. Non occorre digitare Ctrl−C per fermare il ping di Windows: si ferma da solo.

Figura 14−24. Ping da Windows a Linux. Incredibile! Si parlano!

Avete dimostrato che la rete funziona, ed è già tanto. Per ora fermatevi qui e concedetevi una pausa. Se vi interessa
proseguire e potenziare la connessione di rete locale di Linux, ad esempio per trasferire dati da e verso un altro computer
Linux o Windows, leggete il Capitolo 17 (Comunicare con il mondo Windows).

Sostenete Da Windows a Linux!

Questo libro è distribuito gratuitamente, ma le donazioni sono sempre ben accette, sia tramite PayPal, sia tramite il
collaudato sistema della banconota in una busta. Se volete dettagli e istruzioni su come procedere, le trovate presso
http://www.attivissimo.net/donazioni/donazioni.htm.

Grazie!
Da Windows a Linux − (C) 1999−2003 Paolo Attivissimo e Roberto Odoardi.
Questo documento è liberamente distribuibile purché intatto.
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